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LESSON PLAN DATA SHEET 
Course Name En Route Radar Associate Controller Training Part C: Advanced Concepts 

Course Number 55054003 

Lesson Title Review of En Route Decision Support Tool Part 2 

Duration 2 hours 45 minutes (includes lesson, ELT, and part-task exercise) 

Version 1.0 2022.08 

Reference(s) TI 6110.101, En Route Automation Modernization RA-Position User Manual; 
TI 6110.108, ERAM Quick Reference Controller Card; ERAM ATCHI MISC 
230.05, ERAM SRS Air Traffic Computer-Human Interface; ERAM 
CONFLICT AD 220.03, ERAM Conflict Management, Off-Line Problem 
Determination, and Utility Algorithms; ERAM ADAPT AD 220.04, ERAM 
Adaptation Algorithms 

Prerequisites NONE 

Handout(s)  Part-Task Exercise: HO01_L03 (Print prior to class)  
 TI 6110.108, ERAM Quick Reference Controller Card 

Exercise / Activity Refer to handout for: 
 Part-Task Exercise: Review of En Route Decision Support Tool Part 2 

Scenario  Run scenario 55054003_L03_S## in the TTL 

Assessments  YES - Written (Refer to ELT01 L03, print prior to class) 

Materials and 
Equipment 

 Pen and/or pencil  

Other Pertinent 
Information 

 Ensure lesson materials are downloaded to the classroom 
computer 

 Appendix A - TABLE 13-1-1, Clearance Abbreviations 
 Appendix B - TABLE 13-1-2, Miscellaneous Abbreviations 
 Appendix C - TABLE 13-1-3, EDST Equivalents for Control Information 

Symbols 
 Appendix D - Select Manual Strip Marking with EDST Equivalents  
 This lesson is based on ERAM EAE410 
 The lesson has been reviewed and reflects current orders and manuals 

as of April 2022 

 As you prep for this lesson, recall and be prepared to talk about examples and personal 
experiences that illustrate or explain the teaching points in the lesson.  
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LESSON ICON LEGEND 
 

 Description 

 
The Activity icon indicates an exercise, lab, or hands-on activity.  

 
The Discussion Question icon signals a discussion question to be asked to the students.  

 
The Handout icon indicates a handout is to be distributed to the students.  

 
The Instructor Note icon is in hidden text and indicates text that is for the instructor only. 

 
The Multimedia icon indicates a video or audio clip is in the presentation. 

 
The Phraseology icon indicates that phraseology is in the content. 

 
The WBT icon indicates a component of web-based training. 

 
The Click icon indicates a PPT slide with click-based functionality to present additional 
information. 

 
The Definition icon indicates a published definition. 
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LESSON INTRODUCTION 

Overview 

 

1 

 

 
 

En Route Decision Support Tool (EDST) is the interface at the Radar 
Associate (RA) position. Sector teams use EDST in performing their strategic 
planning responsibilities.  

In Lesson 2, Introduction to EDST Part 1, you learned how this tool derives 
expected aircraft trajectories to predict conflicts. 

This lesson will cover the Tools Menu and how to manage airspace, airport 
stream filters, and restrictions. In addition you will learn about NOTAM, GI, 
and SIGMET views, the Wind Grid, the Graphic Plan Display, and free form 
text. 

 



LESSON INTRODUCTION (CONT’D) 
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Lesson 
Objectives 
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  Review the lesson objective. 

 At the end of this lesson, you be able to identify: 

 Features of the Tools Menu 
 Steps to interact with NOTAMs, GIs, and SIGMETs views 
 Weather and altimeter displays of EDST 
 Functions of the Graphic Plan Display (GPD) 
 EDST free form text 

NOTE: There will be a graded end-of-lesson test upon completion of the 
lesson. The passing score is 70%. If you do not achieve a score of 70%, you 
will be provided study time and one retake of an alternate end-of-lesson test. 
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TOOLS MENU 

Options Menu 

TI 6110.101, 
sec. 4.21.3 

ERAM ATCHI 
MISC 230.05, 
par. 3.7.17.6 

3 

 

 

 

 
 

 Slide is animated, 2 clicks. Click where indicated by click icon. 

 Tools… button on the ACL menu bar is used to open the Tools Menu 

 The Tools Menu is opened via: 

 Click to open Tools Menu. 

 Click to open Options. 

 TBP Tools…>Options… 
 Options Menu has four selection boxes: 

 Display Coordination Column 
− TBP to display the coordination column in the ACL 

 Drop Track Delete 
− TBP to specify whether dropped tracks are to be deleted 

immediately from the ACL vs. the default mode of timing out from 
the ACL 

Continued on next page 
 



TOOLS MENU (CONT’D) 
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Options Menu 
(Cont’d) 

TI 6110.101, 
sec. 4.21.3 

JO 7110.65, par. 
13-1-9 

ERAM ATCHI 
MISC 230.05, 
par. 3.8.46 

4 

 

 IAFDOF Manual 
− TBP to change automatic IAFDOF indication to manual mode 
− In manual mode you apply or remove the two states of IAFDOF 

coding indicated by yellow and muted yellow colors 
− EDST Inappropriate Altitude for Direction of Flight (IAFDOF) 

feature must be used in the automatic mode (i.e., IAFDOF Manual 
must remain deselected) unless otherwise authorized in a facility 
directive 

 Non-RVSM Indicator 
− When your sector does not contain RVSM altitudes, you have the 

option to display the non-RVSM indicator on the ACL for flights 
expected to enter RVSM airspace 

− The non-RVSM indicator is a coral box displayed to the right of 
the altitude field when a flight is not equipped for RVSM flight and 
the FP assigned altitude, interim altitude, or reported altitude 
(Mode C or pilot reported) is at or above FL290 

− TBP the Non-RVSM Indicator box to display non-RVSM coding on 
the ACL and GPD 

− If your sector contains RVSM altitudes, this menu item will be 
grayed out 

 

 



TOOLS MENU (CONT’D) 
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Airspace 
Status View 

TI 6110.101, 
sec. 4.21.1 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 The Airspace Status View is opened via: 

 Click to open Tools Menu. 

 Click to open Airspace Status view. 

 TBP Tools…>Airspace Status 
 This view allows you to see the current and planned use of Special 

Activity Airspace (SAAs) 
 Designated RA positions may have the capability to: 

 Change the status of SAAs 
 Modify the schedules of SAAs 
 Change the altitude limits of SAAs 

 You may filter the display between SAAs that are of operational interest 
to the sector position and all the SAAs in the local facility 

 You may also be able to display SAAs of adjacent facilities 
NOTE: The Airspace Status View will be covered in detail in a future 
lesson. 

 

 



TOOLS MENU (CONT’D) 
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Airport 
Stream Filter 
Status 
Display 

TI 6110.101, 
sec. 4.21.2 

ERAM ADAPT 
AD 220.04, 
par. 2.7.1.2.2.1 
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 Slide is animated, 3 clicks. Click where indicated by click icon. 

 AIRPORT STREAM FILTERS (ASF) - An on/off filter that allows the 
conflict notification function to be inhibited for aircraft-to-aircraft alerts 
approaching an adapted set of destination airport(s) or departing an 
adapted set of departure airport(s) to prevent nuisance alerts. 

NOTE: Airport stream filters might not be adapted at your facility and/or 
sector position. If the ASF for a sector position is on, aircraft-to-aircraft 
alerts for the specified aircraft are inhibited when the initial points of 
violation are within airspace assigned to the sector position. 

 The Airport Stream Filter Status Display is opened via: 

 Click to open Tools Menu. 

 Click to open Airport Stream Filter Status display. 

 TBP Tools…>Airport Stream Filter Status… 
NOTE: Conflict probe can produce nuisance alerts at sectors with heavy 
arrival and/or departure traffic. 

Continued on next page 



TOOLS MENU (CONT’D) 
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Airport 
Stream Filter 
Status 
Display 
(Cont’d) 

TI 6110.101, 
sec. 4.21.2 

ERAM ATCHI 
MISC 230.05, 
par. 3.7.2 
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 Airport stream filter status display columns: 

 Status 
− Changes the status from on to off 

 Sector 
− Displays sector number servicing the airport(s) 

 “T” 
− Displays “A” for arrival or “D” for departure 

 Airport(s) 
− Displays unique description for each filter 

 Airport stream filter status display buttons: 

 Filter 
− Shows facility-wide ASF status 

 Exit 
− Removes the filter display 

 Explain how multiple alerts for each aircraft are reduced after applying 
the filter. 

 Click to apply filter and close the display. 

 To apply the filter to a specific airport: 

 TBP “On” radio button 
− All aircraft-to-aircraft alerts between flights meeting the criteria are 

suppressed 

 
 



TOOLS MENU (CONT’D) 
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Restrictions 
View 

TI 6110.101, 
sec. 4.21.4 

ERAM ATCHI 
MISC 230.05, 
par. 19 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 The Restrictions View: 
  Is opened via: 

 Click to open Tools Menu. 

 Click to open Restrictions. 

− TBP Flight ID 
− TBP Tools…>Restrictions 

 Provides altitude and speed restrictions to model the trajectory based 
on Letters of Agreement (LOAs) and Standard Operating Procedures 
(SOPs) 

 Allows you to turn restrictions on/off or revert to the prior setting on 
the restrictions 

− If FACILITY-WIDE is displayed 
o View contains all of the restrictions that apply to the facility 

− If SECTOR (sector ID) is displayed 
o View contains only those restrictions for the sector 

Continued on next page 
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Restrictions 
View (Cont’d) 

TI 6110.101, 
sec. 4.21.4 

ERAM ATCHI 
MISC 230.05, 
par. 19 
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 If you cannot change the status of a restriction, its radio buttons are gray 

 The view has eight columns: 

 ON 
− Restrictions are always on (overriding the scheduled restrictions) 

 OFF 
− Restrictions off (overriding the scheduled restrictions) 

 SCH 
− Time restrictions turn on and off based on adaptation 

 STATUS 
− Current status of the restriction 

o ON (active) 
o OFF (not active) 

 NAME 
− Name of the restriction in adaptation 

 START END 
− Times the restrictions are scheduled to be on or active 

o A restriction can be scheduled to be active for two separate 
time periods 

− START indicates the time if set to scheduled SCH 
− END indicates the time restriction will no longer apply 

 A/D 
− Indicates arrival and/or departure 

 AIRPORTS 
− Displays the airports that are affected by the restriction 

 

 



TOOLS MENU (CONT’D) 
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Current 
Restrictions 
Menu 

TI 6110.101, 
sec. 4.21.4 

ERAM ADAPT 
AD 220.04, par. 
2.7.1.2.4.1 
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 Slide is animated, 3 clicks. Click where indicated by click icon. 

 The Current Restrictions Menu: 

  Opened via: 

 Click to highlight Flight ID DAL976. 

 Click to open Tools Menu. 

 Click to open Restrictions. 

− TBP Flight ID 
− TBP Tools…>Restrictions 

 Provides altitude and speed restrictions modeled for a specific flight 
− Allows you to turn restrictions on/off or revert to the prior setting 

 The radio buttons operate in a similar fashion as the Restrictions 
View except: 
− Revert is unique to the Current Restrictions Menu 

o When selected, the aircraft reverts back to the current 
restriction display schedule 

 



TOOLS MENU (CONT’D) 
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Knowledge 
Check 

11 

 

 

 

 
 

Question: What is displayed in the Current Restrictions view? 

 Answer: C. Adapted restrictions for a specific flight 

 

 



TOOLS MENU (CONT’D) 
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Knowledge 
Check 
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Question: What is the purpose of Airport Stream Filters? 

 Answer: A. Suppresses aircraft-to-aircraft alerts for the specific 
airport(s) 

 

 



TOOLS MENU (CONT’D) 
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Knowledge 
Check 

13 

 

 

 

 

 
 

Question: Which view displays the status of active Special Activity 
Airspace? 

 Answer: C. Airspace Status View 

 

 



TOOLS MENU (CONT’D) 
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Knowledge 
Check 

14 

 

 

 

 
 

Question: What are the steps to set IAFDOF to manual? 

 Answer: B. TBP Tools…>Options…>IAFDOF Manual 

 

 



 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 15 

NOTAMS VIEW 

NOTAMS 
View  

TI 6110.101, 
secs. 2.2, 4.5.1 
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 The NOTAMS view is accessed through NOT button on the EDST toolbar  

 Initially displayed at a default location 
 Suppressed via the EDST NOT toolbar button 

NOTE: Currently this function is not used and another method is used for 
NOTAMs. Specific instruction will be given in a later lesson. 

 The NOT button is facility adaptable and might not be displayed in the 
toolbar 
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GENERAL INFORMATION (GI) MESSAGES VIEW 

GI Messages 
View 

TI 6110.101, 
secs. 2.2, 4.6.1 
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 Toolbar GI button yellow text and number indicate new General 
Information (GI) message(s) 

 General Information Messages view is opened by TBP or TBE on the GI 
button 

 The view will be displayed at: 
− The previous location, or 
− The default location if the GI Messages view has not been 

displayed previously 
 A new GI message is indicated by an underline of the time the GI was 

sent 

 A new GI message may be acknowledged by TBP or TBE on the time GI 
was sent 

 New message coding for that message is removed 
 When all new GI messages have been acknowledged: 

− A white check mark “” replaces the number in the toolbar GI 
button 

− GI button text changes from yellow to white 

 



GI MESSAGES VIEW (CONT’D) 
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Forwarding GI 
Messages 

TI 6110.101, 
sec. 4.6.2.1 
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 GI messages may be forwarded to internal facility areas, sectors, and AT 
Specialist positions which have not previously received the message 

 To forward a GI message: 

 TBP on the message to be forwarded 
 When pop-up menu appears, TBP or TBE FORWARD 
 When SELECT SECTOR pop-up appears, TBP all but last sector, 

area, or AT Specialist position 
 TBE the last sector, area, or AT Specialist position 

− If the GI Message is being forwarded to a single position, TBE 
that position to forward the message 

 

 



GI MESSAGES VIEW (CONT’D) 
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Deleting 
Single GI 
Message 

TI 6110.101, 
sec. 4.6.3.4 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Click to show the amendment steps and resulting GI Message View. 

 To delete a single message: 

 TBP or TBE entry to be deleted 
 When pop-up menu appears TBP or TBE DELETE 

NOTE: Deleting a GI Message removes the message from display at your 
sector only. 

 

 



GI MESSAGES VIEW (CONT’D) 
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Deleting 
Multiple GI 
Messages 

TI 6110.101, 
sec. 4.6.3.4 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Click to show the amendment steps and resulting GI Message View. 

 To delete multiple messages: 

 TBP or TBE DELETE in the view header 
 TBP on all entries to be deleted except the last entry 
 TBE the last entry to be deleted 

 

 



GI MESSAGES VIEW (CONT’D) 
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Knowledge 
Check 
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Question: How are new GI Messages indicated on the GI button in the 
toolbar? 

 Answer: C. Yellow text and number 

 

 



GI MESSAGES VIEW (CONT’D) 
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Knowledge 
Check 
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Question: How can you delete multiple GI messages at one time? 

 Answers: B. TBP or TBE DELETE in the header>TBP each GI but the 
last>TBE the final GI 
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SIGMETS VIEW 

SIGMETS 
View 

TI 6110.101, 
secs. 4.4.1, 
4.4.3.4, 4.4.3.8 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 Toolbar SIG button yellow text and number indicate new message(s) 

 Click to highlight SIG on toolbar. 

 SIGMETS view is opened by TBP or TBE on the toolbar SIG button 

 The view will be displayed at: 
− The previous location, or 
− The default location, if the SIGMETS view has not been displayed 

previously 
 SIGMETS view entries include messages as follows: 

 SIGMETs (SIGMET/WS) 
 Convective SIGMETs (SIGMET/WST) 
 Airmen’s Meteorological Information (AIRMET/WA) 
 Center Weather Advisories (CWA) 
 Urgent Pilot Weather Reports (Urgent PIREP/UUA) 
 Meteorological Impact Statements (MIS) 

 

Continued on next page 



SIGMETS VIEW (CONT’D) 
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SIGMETS 
View (Cont’d) 

TI 6110.101, 
secs. 4.4.3.4, 
4.4.3.5, 4.4.3.8, 
4.4.3.9 
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 A new SIGMET message is indicated by an underline of the time the 
message was sent 

 Click to highlight time on acknowledged SIGMET. 

 A new SIGMET message may be acknowledged by TBP or TBE on 
the time the message was sent 
− New message coding is removed 
− When all new messages have been acknowledged: 

o A white check mark “” replaces the number in the toolbar 
SIG button 

o SIG button text changes from yellow to white 

 Point out to the students the changes in the slide to the SIG button and 
removal of the underline of the message sent time. 

 



SIGMETS VIEW (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 24 

SIGMETS 
View - 
Suppress/ 
Restore 

TI 6110.101, 
secs. 4.4.3.4, 
4.4.3.5, 4.4.3.7, 
4.4.3.8, 4.4.3.9 
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 Slide is animated, 7 clicks. Click where indicated by click icon. 

 SIGMETs cannot be removed, only suppressed 

 Suppressing a SIGMET 

 Click to highlight, i.e., select, top SIGMET. 
 Use TBP or TBE to select a SIGMET  

− Two pop-up pick areas appear: SUPPRESS and PRINT 

 Click to suppress highlighted SIGMET. 
 TBP SUPPRESS 

 SIGMET entry is moved to suppressed area 

 The suppressed area is above the unsuppressed area and a gray line 
separates the areas 

 Dependent upon user setting, suppressed entries may be in view or 
hidden 

Continued on next page 



SIGMETS VIEW (CONT’D) 
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SIGMETS 
View-  
Suppress/ 
Restore 
(Cont’d) 

TI 6110.101, 
secs. 4.4.3.4, 
4.4.3.5, 4.4.3.8, 
4.4.3.9 
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 Restore a suppressed SIGMET 

 Click to move cursor to menu “M”. 
 If the VIEW SUPPRESS not activated 

 Click to open view menu. 
− TBP or TBE the “M” in the view header 

 Click to view suppressed SIGMETS. 
o TBP or TBE VIEW SUPPRESS, all suppressed entries now 

appear above the gray line 

 Click to highlight suppressed SIGMET. 
− TBP or TBE the desired SIGMET 

o Two pop-up pick areas appear: RESTORE and PRINT 

 Click to restore SIGMET. 
− TBP or TBE RESTORE 

o SIGMET entry is restored to the Unsuppressed SIGMET Entry 
Area 
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PRINTING - NOTAMS, GENERAL INFORMATION 
MESSAGES, AND SIGMETS  

Printing - 
NOTAMs, GI 
Messages, 
and SIGMETs 

TI 6110.101, 
secs. 4.4.3.5, 
4.5.3.7, 4.6.3.6 
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 You may print from all three views using the following options: 

 Print a single entry 
 Print multiple entries 
 Print all entries 

 

 



PRINTING - NOTAMS, GENERAL INFORMATION 
MESSAGES, AND SIGMETS (CONT’D) 
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Printing a 
Single Entry 

TI 6110.101, 
sec. 4.5.3.7 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Click to show the steps. 

 To print a single entry: 

 TBP or TBE on entry 
 Within entry pop-up, TBP or TBE PRINT 

− Entry will print on a flight strip printer 
NOTE: All entries are eligible for printing, including suppressed entries. 

 

 



PRINTING - NOTAMS, GENERAL INFORMATION 
MESSAGES, AND SIGMETS (CONT’D) 
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Printing 
Multiple 
Entries 

TI 6110.101, 
sec. 4.4.3.5 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Click to show the steps. 

 To print multiple entries: 

 TBP or TBE PRINT button in title bar 
 TBP all entries, except last entry, to be printed 
 TBE last entry to be printed 

 

 



PRINTING - NOTAMS, GENERAL INFORMATION 
MESSAGES, AND SIGMETS (CONT’D) 
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Printing All 
Entries 

TI 6110.101, 
sec. 4.4.3.5 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Click to show the steps. 

 To print all entries: 

 TBP or TBE the “M” pick area in the view header 
 TBP or TBE PRINT ALL button 
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Knowledge 
Check 
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Question: When printing more than one GI message, _____ on all except 
_____ on the last entry. 

 Answer: A. TBP; TBE 
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WEATHER AND ALTIMETER DISPLAYS 

Weather 
Station 
Report View 

TI 6110.101, 
sec. 4.3 

31 

 

 
 

 Slide is animated, 3 clicks. Click where indicated by click icon. 

 The Weather Station Report View provides weather station reported 
information 

 The view is opened via the WX REPORT button on the EDST toolbar 
 Add weather station with keyboard command 

 WR (station ID) KBE 
− The entry of a typed station ID acts as a toggle 

o If the station ID is not in the list, the report is added 
o If the station ID matches an existing station ID, the report is 

deleted 
 A single weather reporting station can be added to or deleted via the WX 

pop-up input box 

 TBP or TBE “M” in the header 
− The view menu appears 

Continued on next page 
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Weather 
Station 
Report View 
(Cont’d) 

TI 6110.101, 
sec. 4.3 
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 Type a weather station ID and press the Enter key 
− If the station ID is not in the list, it will be added 
− If the station ID matches an existing station ID it will be deleted 
− If the station ID syntax is not valid, the input box remains 

displayed and an INVALID indicator is displayed below box 
o The box remains open for you to edit the station ID and 

resubmit 
− The entry of a typed station ID acts as a toggle 

 Click to move cursor to FNB report. 

 Deleting a station with the trackball 

 Place the cursor over the station to be deleted 
− Station has dwell emphasis 

 Click to show highlight and display DELETE pop-up. 

 TBP or TBE 
− Station is highlighted 
− DELETE pop-up appears 

 Click to delete FNB report. 

 TBP or TBE the DELETE pop-up 
− Station is deleted 

 
 



WEATHER AND ALTIMETER DISPLAYS (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 33 

Altimeter 
Settings View 

TI 6110.101, 
sec. 4.8 
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p. 4 
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MISC 230.05, 
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 Slide is animated, 7 clicks. Click where indicated by click icon. 

 The Altimeter Settings View provides altimeter station(s) name, time, and 
setting 

 The view is opened via the ALTIM SET button on the EDST toolbar 
 Station Identifier - The two to five letter identifier of the station where the 

observation was taken 

 Altimeter setting 

 The altimeter setting is underlined if it is below 29.92 
 If the station report is missing, an “-M-” will be displayed 

 Add altimeter station using the keyboard 

 AR (station ID up to 4) KBE 
− The entry of a typed station ID acts as a toggle 

o If the station ID is not in the list, it will be added 
o If the station ID matches an existing station ID it will be 

deleted 
Syntax: AR <LOC ID> (LOC ID) (LOC ID) (LOC ID) 

Continued on next page 
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 Add altimeter station using the menu  

 Click to delete highlight and move cursor to menu “M”. 

 Click to open view menu. 

 TBP or TBE “M” in the header 
− The view menu appears 

 Click to open template and move cursor to new location. 

 TBP or TBE TEMPLATE 
− The template appears and replaces the view menu 

− The template contains 24 cells 

 Click to make cursor active in new cell. 

 TBP or TBE template cell to type in 
− The cell has selection emphasis 

 Click to type station ID. 

 Type the altimeter station name 
− Selection emphasis is removed 
− Typed characters are echoed in the template cell 

 Click to simulate KBE. Cursor will disappear. 

 Press the enter key 
− Altimeter Station name is submitted for system processing 

 There are three possible outcomes: 
− The altimeter setting is added to the view 
− INVALID 

o If command processing fails the syntax check 
− NOT FOUND 

o If command processing passes the syntax check but the 
station name is not found in adaptation 

Continued on next page 
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 Click to close template. 

 Close the template 
− Station ID(s) and the layout in the template are reflected in the 

Altimeter Settings View 
 Deleting a station with the trackball 

 Place the cursor over the station to be deleted 
− Station has dwell emphasis 

 TBP or TBE 
− Station is highlighted 
− DELETE pop-up appears 

 TBP or TBE the DELETE pop-up 
− Station is deleted 

 The following information is provided for each altimeter station entry: 

 Observation time is underlined when it is more than 65 minutes old 
 Setting is underlined if it is below 29.92 
 “-M-” is displayed if the report is missing 

 
 



WEATHER AND ALTIMETER DISPLAYS (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 36 

Knowledge 
Check 

36 

 

 

 

 
 

Question: What will happen if you enter WR DCA on the keyboard and the 
WX view already contains the DCA report? 

Answer: C. DCA report will be deleted from the view 
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Question: How do you access the template for the ALTIM SET view? 

 Answer: A. TBP or TBE “M” in the header 
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Question: You attempt to enter an altimeter station into the ALTIM SET 
template and you get an invalid response. What does this mean? 

 Answer: C. The station ID entered is incorrect 
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Question: How do you remove a weather report with the trackball? 

 Answer: B. TBP or TBE the report>TBP or TBE DELETE 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 The Wind Grid Display contains wind and temperature data  

 The view is opened via the WIND button on the EDST toolbar 
 Date and time of the National Weather Service prediction for the 

specified altitude level is in the menu bar area 
 Wind and temperature data is overlaid on a map of the center sectors 

− Arrows depict wind direction 
o Longer arrows depict stronger speeds 

− Speed is shown in knots 
− Temperature is displayed in degrees Celsius 

 Keyboard commands 
− UU W  

o Forces wind display at default or last displayed altitude 
− UU W <altitude> 

o Forces wind display at a specified altitude 

Continued on next page 
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 When the Show Temp button is visible, winds are displayed 
− TBP to toggle between wind and temperature data 

 Click to demonstrate TBP on Show Temp button and resulting 
temperatures displayed. 

 When the Remove Temp button is visible, temperatures are 
displayed 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 To recenter the map: 

 Click to recenter the map on the Wind Grid display over the EKN airport 
symbol. 

 TBP on the Recenter button 
 TBP over the desired map center point 
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 The current Wind Grid range value is displayed in the Range button 

 A single TBE will increase the range by 25 miles 
 A single TBP will decrease the range by 25 miles 
 If you try to adjust the range lower than the lowest setting or higher 

than the highest setting, an alarm tone will sound 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 The Wind Grid is initially displayed at the default altitude of 29,000’ 

 The displayed altitude can be changed to any value from zero to 59,000’ 

 To change the altitude displaying wind or temperature values 

 TBP on the Altitude button 
− The Altitude Menu is opened 

 Click to open the Altitude Menu. 

 TBP on the desired altitude in the Altitude Menu 
− Desired altitude data is displayed 

 Click to select 140 as the altitude displaying wind values. 

 To exit the Altitude Menu 

 TBP the EXIT button 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 When weather data is unavailable for display: 

 NO WEATHER DATA is displayed in yellow text across the display 
 If the weather data available for display for the selected altitude is older 

than the hour for which it was forecast 

 Time indicator is displayed in yellow indicating stale weather data 

 Click to show the indication of stale weather. 
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Question: What is the keyboard command to show the wind grid display at a 
specified altitude?  

 Answer: C. UU W <altitude> 
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Question: After TBP on Recenter, how do you recenter the map over an 
intersection? 

 Answer: A. TBP over intersection where you want the map centered 

 
 



WIND GRID (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 48 

Knowledge 
Check 

 

 

48 

 

 
 

Question: How do you decrease the range by one 25 mile increment? 

Answer: B. TBP on Range button 
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 Slide is animated, 7 clicks. Click where indicated by click icon. 

 Graphic Plan Display depicts Trial Plans, FPs, and surrounding traffic 

 Access the GPD by using one of the following: 

  TBP or TBE GPD button in EDST toolbar 

−  Click again to close the GPD or use the Exit button in the GPD 
 TBE flight ID 

−  Click on a flight ID to open the GPD with the trajectory 
highlighted 

−  TBP or TBE Exit button to close the GPD 
 TBE an ACL Alert 

−  Click on any ACL alert to open the GPD with that conflict 
highlighted 

−  TBP or TBE Exit button to close the GPD 
 UU G 

−  Enter UU G in MCA to open the GPD 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Title bar is at the top of the GPD and contains the following: 

 Window Menu button 
 Display minimize and maximize or restore buttons 
 Display Title 
 The text Current Time or Future Time is displayed after the GPD title 

 Click to highlight Future Time +2 title bar. 

− In the case of future time 
o The number of minutes the GPD has been moved into the 

future appears after Future Time label 
o GPD border highlighted in white 

Example: Graphic Plan Display - Future Time +2 

Continued on next page 

  



GRAPHIC PLAN DISPLAY (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 51 

GPD Menu 
Bar - General 

TI 6110.101, 
sec. 3.1.1.2 

48c 

 

 

 

 
 

 Slide is animated, 16 clicks. Click where indicated by click icon. 

 Menu Bar buttons access options and menus for managing the GPD map 
and flight display features 

 Recenter button 

 Used to recenter the map 
− Function is similar to the Wind Grid Display 

 Click to show Range callout. 

 Range button 

 Used to change the scale of the GPD 
 A single TBE will increase the range by 25 miles 
 A single TBP will decrease the range by 25 miles 

Continued on next page 
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 Click to show Suppress callout. 

 Suppress or Restore button 

  TBP to suppress the display of data blocks on the GPD that are 
not displaying current or trial plan route data 

  TBP to restore the display of data blocks 

   Map Options... button 

  TBP to open Map Options Menu 

  TBP Map Features… pick area 
− Displays the Map Features Menu 

o TBP to select different map elements and associated labels 
for display or removal 

o Removing a map element will also remove its label; however, 
the label may still be selected for display 

NOTE: Labels are only viewable if the map features are selected 
for display. 

− Map Features Menu options 
o Sector Boundaries 

 Click to suppress Low Sector Boundaries. 

 Click to restore Low Sector Boundaries. 

o Center Boundaries 
o Approach Control Boundaries 
o Special Activities Airspace 
o Airways 

 Click to suppress “V” victor airways 

 Click to restore “V” victor airways 

Continued on next page 
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o Airports and Airport Labels 
o NAVAIDs and NAVAID Labels 

 Click to display NAVAID Labels. 

 Click to suppress NAVAID Labels. 

o Waypoints and Waypoint Labels 

 Click to display Waypoints. 

 Click to display Waypoint Labels. 

o Scale - if selected, the scale indicator is located in the last line 
of the menu bar area, on the left side. 

 Click to suppress waypoint labels and exit Map Features Menu. 

 
  



GRAPHIC PLAN DISPLAY (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 54 

GPD Map 
Symbols 

TI 6110.101, 
sec. 3.1.1.3 

48k 

 

 
 

 Slide is animated, 7 clicks. Click where indicated by click icon. 

 The GPD uses a set of map symbols that are typical of ATC radar or 
Situation Displays 

 Symbols include sector boundaries, center boundaries, airports, fixes, 
approach control boundaries, airways, and intersections 

 Labels can be displayed for fixes, intersections, airports, and Special 
Activity Airspace (SAA) 

 Special symbols used in the GPD include the following items: 
− Sector Boundaries 

o White line 
− Center Boundaries 

o Bold white line 
− Approach Control Boundaries 

o Gray dashed line 

−  Airports 
o White box 

Continued on next page 
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  NAVAIDs 
− VOR and VORTAC 

o White circle 
− TACAN 

o White splat 

  Intersections, Waypoints 
− White plus 

  Victor airways 
− White line 

  Jet routes and Q routes 
− White line 

  Special Activity Airspace Boundaries 
− Solid white line, cold  
− Solid orange line when an airspace alert is displayed 

 Click to show SAA labels callout. 
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 Slide is animated, 10 clicks. Click where indicated by click icon. 

 The AC Display Menu pick area is found in the Maps Options Menu 

  TBP AC Display Menu… pick area 

 Aircraft Display Menu options: 
− Aircraft List Filter 
− Altitude Filter Limits 
− Filter Above and Filter Below 
− Auto Datablock Offset 
− Route Preview 

o  TBP to show 1 minute route preview 

o  TBP to show 2 minute route preview 

o  TBP to show 3 minute route preview 

Continued on next page 
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 Click to close Aircraft Display Menu with Exit and open Aircraft Display 
Menu on the left of screen with AAL001 route showing. 

o MSP and MEP Labels 
o TBP to suppress MSP label 

 Click to suppress AAL001 MSP label. 

o TBP to restore MSP label 

 Click to restore AAL001 MSP label. 

 MANEUVER START POINT (MSP) - Symbology (asterisk) displayed 
on the projected route of flight to indicate when an altitude maneuver is 
predicted to start. Also displays an Up or Down arrow to indicate the 
direction of the maneuver. 

 MANEUVER END POINT (MEP) - Symbology (asterisk) displayed on 
the projected route of flight to indicate when the altitude maneuver is 
predicted to be completed. 

NOTE: The maneuver start and end points are only predictions made by the 
system based on computed trajectory and may not accurately predict what 
the aircraft will fly. 

 Click to exit Aircraft Display Menu. 

  TBP Tools... button 

 Displays the Tools Menu 

  TBP Save GPD Map button 
− Tools…>Save GPD Map pick area 

o Saves current range and center of the GPD map 
o Exiting the GPD without saving causes the map center and 

range to be lost 
 Saved Map button 

 Used to display the most recently saved Graphic Plan Display range 
and map center 
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 Slide is animated, 15 clicks. Click where indicated by click icon. 

 Flight specific Menu Bar buttons become active only when a flight ID is 
selected 

 Plan Options… button 

 Displays the Plan Options Menu for the GPD 
 TBP flight ID 

 Click to highlight AAL001 flight ID. 

− Plan Options…, Hold…, Show, Show All, Graphic… buttons 
become active 

  TBP Plan Options button to open that menu 

  TBP Exit to close 

Continued on next page 
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 Hold... button 

 Displays the Hold Data Menu 

  TBP to open Hold Menu 

  TBP Exit to close 
 Clean Up button 

 Used to remove projected route lines for current and trial plans as 
well as alerts from the GPD 

 Click to cleanup the display. AAL001 highlight removed. 

 Show... button 

 Used to graphically display or remove a selected aircraft’s current 
plan and any specific alert assigned to the users sector 

 TBP alert 

 Click to select orange SAA alert for N301 

− Show button becomes active 

  TBP Show to display the alert 

  TBP Clean Up to clear 
 Show All... button 

 Used to graphically display or remove a selected aircraft’s current 
plan and all the alerts associated with the selected aircraft 

 TBP the flight ID 

 Click to select N301 flight ID. 

− Plan Options…, Hold…, Show, Show All, Graphic… buttons 
become active 

  TBP Show All to display all alerts 

  TBP Clean Up to clear 

Continued on next page 
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 Graphic... button 

 Used to create graphical trial plans for route amendments 
 TBP the flight ID 

 Click to select SAM001 flight ID 

− Plan Options…, Hold…, Show, Show All, Graphic… buttons 
become active 

  TBP Graphic… to enter graphic mode 
− Covered in future lesson 

  Template... button 

 Opens the Flight Plan Template to create a FP if no entry is selected, 
or  

 Opens the Amendment Template to amend a FP if an entry is 
currently selected 
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 Slide is animated, 1 click. Click where indicated by click icon. 

 Due to Reason Chevron, AM+Uplink, Amend, and Interim buttons 
become active once a specific trial plan or amendment plan is selected 

Example: SAM001 has a trial plan for FL240. 

 Click to show a TBP on the trial plan ID. 

 TBP the trial plan ID to activate the following Menu Bar buttons: 

 Due to Reason Chevron 
− Due to Reason buttons are messages that can be appended to 

the uplink request 
 AM+Uplink 

− Used to send and uplink an amendment 
 Amend 
 Interim 

− Used to send an interim altitude message to the system based on 
a Trial Plan 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 Each aircraft is represented by a position symbol and if selected, a 
projected flight path 

CAUTION: The GPD may resemble radar, but it is not radar. The GPD uses 
coding techniques to draw your attention to a particular data block, FP, or 
one of its components. 

 Click to show white chevron. 

 White chevrons 

 Used to mark the location of the beginning and end points of the 
TFM-protected segment of a route 
− Bisect the route line, pointing inward towards the protected 

segment of the route 

Continued on next page 
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 Click to show coral “A”. 

 Coral “A” 

 A Non-Automated Dependent Surveillance-Broadcast (ADS-B) 
indicator is displayed when the track indicates that there is no ADS-B, 
and the NON-ADSB button in the Toolbar is selected 
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 The GPD data blocks look similar to full data blocks displayed on the R 
Position Situation Display 

 Data Block Lines 

 Line 0 - Alert Indicators 
 Line 1 - Aircraft ID 
 Line 2 - Altitude 
 Line 3 - Destination and Ground Speed 
 Line 4 - Flight Plan Assigned Altitude, Block Altitude, or Time at 

Coordination Fix 

Continued on next page 
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 Review the data block examples. 

Examples: UAL011 and UAL212, line 0, yellow alerts 

SLAM31, line 4, climbing to a block altitude 

UAL215, Line 2 and line 4, interim altitude with assigned altitude 

UAL006, Line 0, not probed 

UAL017, line 4, inadequate track data, time at coordination fix 
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 Slide is animated, 5 clicks. Click where indicated by click icon. 

 Using the GPD data block 

 TBP and hold the data block, leader line, or projected route line and 
drag 

 Click to move AAL001 data block. 

 Click to move off screen data block of N302. 

− Moves the data block to a new location 
− Release TBP to place the data block 

 TBP on the altitude field in the data block  

 Click to open altitude menu SWA052. 

− The altitude field in the GPD data block is highlighted 
− The Altitude Menu is displayed 

Continued on next page 
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 TBP on the destination field in the data block 

 Click to open route menu SWA052. 

− The destination field is highlighted 
− The Route Menu is displayed 

 TBP on the speed field in the data block  

 Click to open speed menu SWA052. 

− The speed field is highlighted 
− The Speed Menu is displayed 
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 Slide is animated, 5 clicks. Click where indicated by click icon. 

 The GPD Future Time bar scrolls time into the future 

 This allows you to look at and evaluate the graphical situation up to 
20 minutes out 

 Use the trackball to select a future time in any of the following ways: 
− TBP and hold on the slider and move it across the bar and 

release at the desired time increment 

 Click to simulate dragging time bar slider to 3 minutes. 

− TBP anywhere on the Future Time bar to move the slider towards 
the cursor in one-minute increments 

 Click 3 times to move time to 6 minutes. 

− TBE anywhere on the Future Time bar and the slider will 
automatically move to that time increment 

Continued on next page 
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 Click to move time to 13 minutes 

 When the Future Time bar is used to display projected GPD data at a 
specified time in the future, the white border around the entire GPD 
becomes a wider whiter border  

 Alert coding is not impacted by future time display 
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Knowledge 
Check 
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Question: How can you determine if a GPD track has no ADS-B? 

Answer: B. Coral “A” adjacent to the track symbol 
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Knowledge 
Check 
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Question: What does 280 mean in this GPD data block? 

Answer: C. Assigned altitude 

 
 

 

 



GRAPHIC PLAN DISPLAY (CONT’D) 

FAA55054003-LP03 / V1.0 2022.08 INSTRUCTOR LESSON PLAN Page 72 

Knowledge 
Check 

 

 

48w 

 

 

 

 

 

 
Question: How can you determine if the GPD is displaying future time? 

Answer: A. Future time is displayed in the GPD header 
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Knowledge 
Check 
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Question: What is the keyboard command to open the GPD? 

Answer: B. UU G 
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Knowledge 
Check 
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Question: How would you access the menu to display or remove SAA labels 

on the GPD? 

Answer: C. TBP Map Options>Map Features 
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Knowledge 
Check 
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Question: How are TFM-protected routes depicted on the GPD? 

Answer: A. White chevrons bisecting the route 
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FREE FORM TEXT 

Record Data 

JO 7110.65, par. 
13-1-8,         
TBL 13−1−1, 
TBL 13−1−2, 
TBL 13−1−3 
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 Slide is animated, 2 clicks. Click where indicated by click icon. 

 Control information not otherwise recorded via automation recordings or 
voice recordings must be manually recorded using approved methods 

 Click to open free text area LN352HS. 

 When an ACL or DL entry’s free text area is used to enter control 
information, you may use: 

 Click to show control instructions for LN352HS. 

 Clearance abbreviations 
 Miscellaneous abbreviations 
 EDST equivalents for control information symbols 
 Plain language markings when it will aid in understanding information 
 Locally approved abbreviations 

Continued on next page 
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Record Data 
(Cont’d) 

JO 7110.65, par. 
13-1-8,         
TBL 13−1−1, 
TBL 13−1−2, 
TBL 13−1−3 
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 Review example from slide below. 

Example: D-A -TFD RV 50 ✱400 AF10 MIN✱ V0040 ✱45✱ C132.9 

D-A Cleared to depart KCGA (Casa Grande Municipal Airport) to 
CYKA (Kamloops) 

-TFD Direct to TFD (Stanfield VORTAC) 

50 Climb and maintain 5,000’ 

✱400 AF10 MIN✱ Expect FL400 after 10 minutes 

V0040 ✱45✱ Clearance void 0040, advise by 0045 

C132.9 Contact frequency 132.9 

 Free text area must remain open and visible when it contains control 
information 

 When no longer relevant, the information entered into the free text area 
must be updated or deleted 

 Control information entered in the free text area must be used for 
reference purposes only 

 Information entered into the free text area is not forwarded and, if 
necessary, must be coordinated 
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Authorized 
Abbreviations 

JO 7110.65, 
TBL 2-3-11,  
TBL 2-3-12, 
Figure 2-3-7, 
TBL 13−1−1, 
TBL 13−1−2, 
TBL 13−1−3 

ERAM ATCHI 
MISC 230.05, 
par. 6.8.1 
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 ACL and DL free text areas cannot accept all manual strip marking 
symbols for control information, but instead use the following: 

 Appendix A, Clearance Abbreviations 
 Appendix B, Miscellaneous Abbreviations 
 Appendix C, EDST Equivalents for Control Information Symbols 

NOTE: Appendix D, compares select manual strip marking with approved 
free text control instructions 

 Explain how strip marking annotations, shown in blue, can be 
abbreviated in the free text area. 
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Knowledge 
Check 
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Question: When must the free text area be open and visible? 

 Answer: C. If it contains control instructions 
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Knowledge 
Check 
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Question: When can plain language be used in the free text area for control 
instructions? 

 Answer: B. To aid in understanding information 
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PART-TASK EXERCISE: EDST PART 2
 

 
 

Purpose 
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Perform the following tasks: 

 Identify features of the Tools Menu 

 Demonstrate GI Message View and SIGMETS View features 

 Identify weather and altimeter displays 

 Interact with the GPD 

Materials 
 

 Handout: HO01_L03 

 TTL part-task exercise: EDST Part 2 

 TTL Scenario: 55054003_L03_S## 

Directions 
 

This exercise takes approximately 45 minutes to complete. Each student 
must complete the checklist tasks. No headsets are required. 

 Provide instruction as required. Check off each task after completion. 
No Ghost Pilots are required.
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CONCLUSION 

Lesson 
Summary 
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 Review and elaborate briefly on the following topics. Ask students if 
they have questions about any of the concepts covered in the lesson. 

 Features of the Tools Menu 

 Options Menu 
 Airspace Status View 
 Airport Stream Filter Status Display 
 Restrictions View 
 Current Restrictions View 

 Steps to interact with NOTAMs, GIs, and SIGMETs Views 

 NOTAMS View - access 
 GI Messages View - access 

− Forwarding GI messages 
− Deleting single GI message 
− Deleting multiple GI messages 

 SIGMETS View - access 

Continued on next page 
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Lesson 
Summary 
(Cont’d) 
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 Printing - NOTAMs, GI messages, and SIGMETs 
− Printing a single entry 
− Printing multiple entries 
− Printing all entries 

 Weather and altimeter displays 

 Weather Station Report View 
 Altimeter Settings View 
 Wind grid  

− Layout and function 
− Recenter 
− Change range 
− Change display altitude 
− Problem indication 

 Graphic Plan Display 

 Access 
 Layout 
 Map symbols 
 Aircraft Display Menu 
 Menu bar 

− General 
− Flight specific 
− Plan specific 

 Main display area and route symbols 
 GPD data block 
 Future Time bar 

 EDST free form text 

 Hand out and administer the End-of-Lesson Test. Provide feedback on 
missed items, including why particular answers are correct, as well as why 
some responses are incorrect. 
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APPENDIX A 
 

Clearance Abbreviations 

Abbreviation  Meaning 
A Cleared to airport (point of intended landing) 
B Center clearance delivered 
C ATC clears (when clearance relayed through non-ATC facility) 

CAF Cleared as filed 
D Cleared to depart from the fix 
F Cleared to the fix 
H Cleared to hold and instructions issued 
N Clearance not delivered 
O Cleared to the outer marker 

PD Cleared to climb or descend at pilot's discretion 

Q Cleared to fly specified sectors of a NAVAID defined in terms of courses, 
bearings, radials, or quadrants within a designated radius 

T Cleared through (for landing and takeoff through intermediate point) 
V Cleared over the fix 
X Cleared to cross (airway, route, radial) at (point) 
Z Tower jurisdiction 
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APPENDIX B
 

Miscellaneous Abbreviations 

Abbreviation Meaning 
BC Back course approach 
CT Contact approach 
FA Final approach 

FMS Flight management system approach 
GPS GPS approach 

I Initial approach 
ILS ILS approach 
MA Missed approach 

NDB Nondirectional radio beacon approach 
OTP VFR conditions-on-top 
PA Precision approach 
PT Procedure turn 
RA Resolution advisory (Pilot’s reported TCAS event) 
RH Runway heading 

RNAV Area navigation approach 
RP Report immediately upon passing (fix/altitude) 
RX Report crossing 
SA Surveillance approach 
SI Straight-in approach 
TA TACAN approach 
TL Turn left 
TR Turn right 
VA Visual approach 
VR VOR approach 
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APPENDIX C
 

EDST Equivalents for Control Information Symbols 

Abbreviation  Meaning 
T dir  Depart (direction if specified) 

↑ Climb and maintain 
↓ Descend and maintain 

CR  Cruise 
AT  At 
X  Cross 
M  Maintain 

/ airway  Join or intercept (airway, jet route, track, or course) 
=  While in controlled airspace 

WICA  While in control area 
dir ECA  Enter control area 

dir OOCA  Out of control area 

dir ESA Cleared to enter surface area. Indicated direction of flight by appropriate 
compass letter(s) 

TSA alt 
Through surface area and altitude indicated direction of flight by appropriate 
compass letter(s). Maintain special VFR conditions (altitude if appropriate) 
while in surface area 

250 K Aircraft requested to adjust speed to 250 knots 
-20 K Aircraft requested to reduce speed 20 knots 
+30 K Aircraft requested to increase speed 30 knots 

SVFR Local Special VFR operations in the vicinity of (name) airport are authorized 
until (time). Maintain special VFR conditions (altitude if appropriate) 

B4  Before 
AF  After or Past 
/  Until 

✱instructions✱  Alternate instructions 
REST  Restriction 
AOB  At or Below 
AOA  At or Above 

- From-to (route, time, etc.) 

(Alt)B(Alt) Indicates a block altitude assignment. Altitudes are inclusive, and the first 
altitude must be lower than the second (Example 310B370) 

 

Continued on next page 
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APPENDIX C
 

EDST Equivalents for Control Information Symbols 

Abbreviation  Meaning 
V time Clearance void if aircraft not off ground by time 

CL  Pilot canceled flight plan 
+info+ Information or revised information forwarded 

✱✱alt✱✱ Other than assigned altitude reported Example: ✱✱50✱✱ 
ARC mi. dir.  DME arc of VORTAC or TACAN 

C freq. Contact (facility) or (freq.), (time, fix, or altitude if appropriate). Insert frequency 
only when it is other than standard 

R  Radar contact 
R alt  Requested altitude 
R/ Radar service terminated 
RX Radar Contact Lost 
RV Radar vector 

RVX Pilot resumed own navigation 
HO  Handoff completed 
E  Emergency 
W  Warning 
P Point out initiated. Indicate the appropriate facility, sector, or position. 

FUEL  Minimum fuel 
EFC time  Expect further clearance at (time) 

- fix Direct to fix 
FRC  Full route clearance 
IAF  Initial approach fix 

NORDO  No Radio 
PT  Procedure turn 

RLS  Release 
REQ  Request 

SI  Straight in 
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APPENDIX D
 

Table compares select manual strip marking with EDST Equivalents for Control Information 
Symbols. 

Manual Strip 
Marking 

EDST Free 
Text Meaning 

 T dir Depart 

 ✱instr✱ Alternate Instructions 
 AF After 
 B4 Before 

 V time Void after 

 CL Cancel IFR 

 REST Restriction Bar 

 AOA At or Above 

 AOB At or Below 
 ✱✱alt✱✱ Other than assigned  

 CR Cruise 

 HO Radar Handoff Complete 

 RX Radar Contact Lost 

 R/ Radar terminated 

 / airway Join 

 ARC mi. dir. DME Arc 

 C freq Contact Communications 

 AT At 
 = While in controlled airspace 
 WICA While in control area 

 dir ECA Enter control area 

 dir OOCA Out of control area 

 dir ESA Cleared to enter surface area. Indicated direction of flight by 
appropriate compass letter(s) 

 TSA alt 
Through surface area and altitude indicated direction of flight 
by appropriate compass letter(s). Maintain special VFR 
conditions (altitude if appropriate) while in surface area 

 
SVFR 

Local Special VFR operations in the vicinity of (name) airport 
are authorized until (time). Maintain special VFR conditions 
(altitude if appropriate) 

 ‒ From-to (route, time, etc.) 

 +info+ Information or revised information forwarded 
 EFC time Expect further clearance at 
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